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Abstract

This guide provides users of DTS File Security Manager (FSM) an understanding of how to use
the product including insight into getting around in the User Interface. After reading the
information within this document the user will understand how to use FSM to improve the state of
their storage infrastructure.
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The information contained in this document is believed to be accurate as of the date of
publication. Because DTS must constantly respond to changing market conditions, what is
here should not be interpreted as a commitment on the part of DTS, and DTS cannot
guarantee the accuracy of any information presented after the date of publication.

This document is for informational purposes only. DTS MAKES NO WARRANTIES,
EXPRESS OR IMPLIED, IN THIS DOCUMENT.

All product and company names mentioned herein may be the trademarks of their
respective owners.

DTS, 31 Emerald Drive, Derry, NH 03038, USA
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Introduction

DTS File Security Manager (FSM) is a valuable component of an overall storage resource
management (SRM) architecture and helps organizations close critical security loopholes that
often go unaddressed while also enhancing the performance and functionality of many critical
storage management products including those that handle quota management, storage reporting
and storage chargeback.

This document is a guide to the successful utilization of DTS FSM.

Before You Begin

FSM is designed to be used by administrators to carry out administrative tasks that have a
positive impact on system security. The application will not be able to change the ownership and
permissions of files and directories if the user running the program does not have administrative
privileges on the storage being managed.

Purpose

DTS FSM is designed to resolve the problems that arise from file and directory ownership and
permissions not being maintained. While Windows has always allowed Administrators to take
ownership of files and directories and in recent versions has allowed Administrators to assign
ownership, the interface to make these changes is not practical when confronted with a multiple
terabyte system. The same issues that make ownership onerous to manage are amplified by the
additional layers of complexity when setting permissions on unstructured data. By providing a rule
based system that can run though a massive amount of data and applies rules, DTS FSM makes
maintaining file and directory permissions and ownership on even the largest storage systems
easy.

Editions Available

DTS FSM is available in five editions from Basic Edition to three storage platform specific
Enterprise Editions.

Basic Edition — Provides utility functionality for organizations that just want to target a
small number of specific files and directories and set ownership and permissions
manually. This edition does not include the advanced Rule and Rule Set functionality
available in the other editions. The Manual Mode described in this document defines the
complete functionality of the Basic Edition.

Professional Edition — Provides all of FSM’s functionality for local drives on the system
where the software is installed. This edition does not support remote drives or UNC
paths and does not support Home Directory rules which require integration with Active
Directory.

Enterprise Edition — Provides the ability to create Rule Sets that run against local
drives, mapped drives and UNC paths. The Enterprise Edition also provides for Rules
that specifically integrate with Active Directory to fix permissions and ownership based on
Home Directories also known as Home Directory rules.
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For all editions licensing is by server. In the case of the Basic and Professional Editions you must
install the software on all computers where you desire the functionality. The Enterprise Edition
allows for centralized administration with licenses priced based on platform including SAN and
NAS licenses in addition to Standard Windows Server licenses.

Getting started

After installing FSM and activating the license (see a later section of this document or the DTS
FSM Installation Guide for details) open up FSM and you will be shown the main interface for the
program (shown below). When first installed there are no Rule Sets defined.

@ File Security Manager BEIL

File  Run  Configuration  Reporting  Languages  Help

== Manage Rule Set
A g

Create, edit or un a Rule Set
Rule Set Name | Number of Fules Defined | Date Created

Edit Delete Copy Fiun

Creating Test Rule Sets

By default the program does not have any Rule Sets defined, but to help you get up and running
quickly the product provides you with the ability to create test Rule Sets under the File menu.
The Create Test Rule Sets option (shown below) opens a dialog that gives you options for the
Rule Sets that are created for your testing.

@ File Security Manager
File | Bun  Configuration Reporting Languages Help
Mew Rule Set  Ctrl+N

Edit RuleSet  Ctrl+E le Set

Delete Rule Set Del

| Create Test Rule Sets | [ Number of Rules Defined | Date Created
Exit Alt+F
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The purpose of the Create Test Rule Sets functionality is to create a test directory structure (it
defaults to the Test directory under the FSM install directory, but is configurable) and pairs of
Rule Sets that allow you to change the ownership of the Test directory structure back and forth
between the Administrator and the current logged in user by running the Rule Sets (configurable
via the dialog shown below) and/or change the permissions of the Test directory structure by
granting the current logged in user Full Control permissions and removing that permission by
running the Rule Sets. The resulting dialog allows you to quickly specify the parameters for the
Test Rule Sets that will be created including whether they use business names for the file
structure or just test directory names (Realistic Names vs. Utilitarian Names option).

D creste Tes ke st S ===

To create Rule Set that will allow you to test your installation fill in the information or accept
the defaults and Click Create. The system wil create a directory structure and two Rule Sets
that will allow you to change permissions or ownership for easy testing.

You can modify the Rule Sets as you see fit fortesting.

Rule Type
| (7) Ownership Rule () Permission Rule @ Both Ownership and Permission Rule I
Path to create test directories and files (defaults to installation directary)
C:\Program Files (86D TS%FSM Browse
Test Directory Name: o i
Test =
@ Realistic Names
Base Rule Set Name: i
Demo Rule Set ) LKilitarian Mames
User 1 (defaults to logged in user)
DTS
User 2 (defaults to Administrator )
DTS Administrator

| Create || Cancel |

After you have clicked on the Create button with the default settings you end up with one or more
pairs of Rule Sets defined as shown below.

@ File Security Manager

File  Run  Configuration Reperting Languages Help

== Manage Rule Set
f g

Create. edit or un a Rule Set

Rule Set Name MNumber of Rules Defined Date Created
Dema Rule Set 1- DTS'phynds Takes Ownership 8/28/2011
Demo Rule Set 1- DTS Administrator Takes Ownership 1 3/28/2011
Dema Rule Set 1- DTSphynds Grant Full Control 1 8/28/201
Demo Rule Set 1- DTSphynds Revoke Full Control 1 8728201
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Using Manual Mode

Even before you create your first Rule Sets you can use the Manual button to quickly and easily
set file and directory permissions and ownership. The Manual Mode functionality is the quickest
way to set the security on a small number of files and/or directories. You can reach the Manual
Mode interface through the Run menu by selecting Manual Mode or by clicking on the Manual
button on the main interface. The Manual Mode screen contains all the functionality available in
the DTS FSM Basic Edition and is shown here (see below).

@ Manual Mode E@E |

Directory Selection: Fitter Files by name (Example *jpg): Group or user names:
G- Citrix €2 BUILTIN' Admiristrators
(- Common Files €7 BUILTIN'Users

& Capor Dol Cebtowns |

- Del Owner File €0 NT AUTHORITY\SYSTEM
- Dell DataSafe Local Backup

- DTS

BUILTIN'Administrators Backup-January bd
BUILTIN'Administrators Project_Input.doc

H- Google DTSphynds

- HP Pemissions for DTS phynds
- HTML Help Workshop
[-iFtLIVE Full Control
- 115 )
- IS Express Madify
[#- Install Shield Installation Information Read & Execute
1. Intermet Fenlnner B

4 [ | + Read

EEEEO

New Owner to Assign: Selected File: Wiite

DTS\phynds Backup-January bd i Special Permissions

Selected Directory Cumrent Owner: Selected Directory:
BUILTIN'Administrators C:\Program Files 6c86)\DTS\FSM\Test\Data i [ Refresh ] [ Advanced
Permissions Applied on File

MNumber of Files 2 Elapsed Time: 76 ms

The example of using Manual Mode pictured above shows files in the selected directory owned
by the BUILTIN\Administrator. The current logged in user is Phynds from the DTS domain and
that user becomes the default for the New Owner to Assign when the screen loads (but can be
changed manually or by clicking on the Select User button). Clicking on the Assign Owner
button next to the selected file will reassign ownership of that file to DTS\Phynds. On the far right
of the screen you see the permissions controls which allow the permissions to be quickly and
easily set for the selected file or directory.

Anatomy of a Rule Set

The Rule Set defines what needs to be changed and where on the storage system. Rule Set
definitions consist of the Rule Set nhame, the rules that make up the Rule Set and the drives
and/or paths that the Rule Set is applied against. The interface for creating and editing a Rule
Set is shown below with both the Summary (where rules are listed) and Select Where Rules
Apply (where the rule applies on disk) tabs displayed.
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0 Rule Set Definition O, = =

Sl

aeH—

Rule Set Definition

Summary | Select Where Rules Apply | Reporting |

Rule Set Mame: Demo Rule Set 1- DTS phynds Takes Ownership

MNumber of Rules Defined: 1
Rules that make up this Definition:

Rule Mame
DTS5 phynds Takes Ownership

Files ar Directories
DTSphynds

0 Rule Set Definition O, = =

Sl
aeH—

Rule Set Definition

Rule Set Mame: Demo Rule Set 1- DTS phynds Takes Ownership

Summary | Select Where Rules Apply | F{epgml

Select where this rule set will be applied

Directory Bxclusions
Exclude Directories Named

) (20 ]

[#-[| Dell DataSafe Local Backup
=-[]DTsS
=[] FSM
LClde
- [Tles
=[] Test
..[#] Data

i eMule

-] Google

[T HP

--[JHTML Help Waorkshop
o [TliFR 1 IWVE

[] Bxclude Sub Directories
Mote: Directories excluded can be

Ciptions
Include Sub Directories
Unselect Sub Directories

[7] Bxclude top directory

separated by commas and can use wild cards.

Copyright © 2011 by Derry Technological Services, Inc. All rights reserved.
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The Rules can be configured with ultimate flexibility. In the screenshot below you see that you
can add criteria to have a rule only effect files or directories (also configurable) owned by a
specific user or based on the file size, file age or file extension as well as the name pattern of files
or directories. The Configure Rule Settings screen shown below is quite easy to use provided
you know what you wish to accomplish.

Rule Type

&% Configure Rule Settings © Omnershp Fue

=
) Pemission Rule

Rule Mame: Find Orphaned 510s

Mew Owner Criteria (Required) Rule Applies To

@ Specify New Owner:  DTS\phynds @ Files Only

71 Set the New Owner of files to the Owner of the Directony ) Directories Only

(@ Home Directory Rule: | Grant user ownership of their Home Directary () Both Files and Directoriss

Rule Criteria (configuration of criteria settings is optional)

[T Pemission Criteria: Domain'.Usemame Select User | | Full Control

Current Owner Criteria: Select User Unlenown User
[ File Size Criteria: : : hat & 5 10 —| |KB
[ File Age Criteria: - e Date Accessed - 1 = |Manthis)

[C] File Extension Criteria: Input List of Extensions (comma separsted) such as: bt exe doc xs

[C] Name Pattem Ciiteria:  |Input Name Pattem such as: sec™ doc or forecast. lUse Regex

Save Rule ] l Cancel

Running a Rule Set

Once you have your Rule Set defined as desired you can run it from the main screen by selecting
it and clicking on the Run button. By default the Run Rule Set screen will be configured to run the
Rule Set in Test Mode. In Test Mode, no changes are made on the file system, but the output
shows you exactly what will happen when you run in Live Mode. As the Rule Set runs the
statistics section shows details about the progress including the number of errors encountered,
files modified, directories modified and total number of files and directories processed. Below are
screenshots that show of what the output looks like after a Rule Set has been run (in this case
one of the Test or Demo Rule Sets). The first screen below shows the output screen scrolled all
the way to the top and the second with the output screen scrolled to the bottom.

Copyright © 2011 by Derry Technological Services, Inc. All rights reserved. Page 9
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() Run Rule Set ESSEE)

=% Rule Set:
Demo Rule Set 1 - DTS\phynds Takes Ownership

m Select Run Mode

—rorr = () Test Mode:
= rocessin un: =
Stated 8/28/2011 1113 PM UG IR e i

@ Live Mode:
Rules (1): :
DTS'phynds Takes Ownership - Both Logging and changes.
Top Level Paths to process (1):
C:\Program Files (<BENDTSA\FSMATest™™

Start ] l Close
Statistics:
Emors:

Progress

Starting =can of C:\Program Files 86D TSWFSM Test'”

Ownership Changes on Directory:
C:\Program Files (B6\DTSYFSMYTest' Files Processed:
Rule: DTSYphynds Takes Ownership

New Cwner: DTS\phynds Directories Processed:
Cld Owner: BUILTIN'Administrators Objects Processed/Sec

Ownership Changes on Files in:

C:\Program Files &86)\DTS FSM Test Objects
Project Overview doc

Filez Modified:

Rule: DTS phynds Takes Cwnership ) . !
New Owner: DTS'\phynds Directories Modified:
Old Owner: BUILTINAdministrators

Operations
Site_Graphic.bmp File Alterations:

Rule: DTSYphynds Takes Ownership ) .

New COwner: DTS'phynds Directory Alterations:

Time Elapsed: 00:00:00.772 | Logging Level: Minimal | Real Time Output Level: Max

ol

=% Rule Set:
Demo Rule Set 1 - DTS\phynds Takes Ownership

W’m Select Run Mode

e — e ) Test Mode:

Ownership Changes on Directory: Foggmg Ay g
C:\Program Files (¢86J\DT5"F5SMTest'Resources ©) Live Mode:
Rule: DTSYphynds Takes Ownership Logaing and changes.
New Owner: DTSphynds
Old Owner: BUILTIN Administratars

Start ] l Close
Ownership Changes on Files in: SRR
C:\Program Files (<B6/\DTS\FSM\Test\Resources Statistics:
Managers File doc Ermors:
Rule: DTSphynds Takes Ownership Progress
New Owner: DTS phynds
Old Owner: BUILTINAdministrators

Filez Processed:

Scheduli Directories Processed:
Lling xdsx
Rule: DTSYphynds Takes Ownership DObjects Processed/Sec
New Owner: DTS phynds

Old Owner: BUILTINAdministrators

Dbjects

Files Modffied:
%Lz%is:;:ds?%gf%::plée: . Directories Modfied:
Directory Aterations: 3 directories File Alterations:
Sean Duration: 000000772 Drecory Atrations:

Time Elapsed: 00:00:00.772 | Logging Level: Minimal | Real Time Output Level: Max

Copyright © 2011 by Derry Technological Services, Inc. All rights reserved. Page 10
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Languages Supported

DTS FSM currently supports English, German, Spanish and French. By default the program will
use the locale setting defined on the system on which FSM is installed, but if you would like to
change the system to use another language independent of the locale setting the Language
menu allows you to override with whatever language you prefer (of those supported of course).
In the screen below you can see what the main screen looks like when German is choose under
the Language (Sprachen after the change).

J Dateisystem Master: Hilft Thnen F

Datei  Starten  Konfiguration  Reporting  Sprachen  Hilfe

*= Regelgruppe managen

Regelgruppe erstellen, editieren oder starten
Regelgruppe Name Zahl von Richtlinien definierte Datum erschaffen
Demo Rule Set 1- DTSphynds Takes Ownership &/28°2011

Demo Rule Set 1 - DTS\ Administratar Takes Ownership
Demo Rule Set 1 - DTS phynds Grant Full Control
Demo Rule Set 1- DTSphynds Revaoke Full Control

Copyright © 2011 by Derry Technological Services, Inc. All rights reserved. Page 11
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Configuration Options

Database Configuration

DTS FSM uses a backend database to store application settings including the Rules and Rule
Sets. The system supports Microsoft Access and installs and uses an Access MDB named
FSM.mdb by default. The system also supports Microsoft SQL Server if desired (contact DTS for
instructions to create the Microsoft SQL Server version of the FSM backend database). The
Database Configuration screen (shown below) is accessible via the Configuration menu on the
main screen.

J ﬁ.‘latahase Configura -- ] LEIL .l

Database Type Access File (Path and File Name)
@ MS Access MProgram Files 860D TSWFSMWFSM.mdb

Password (f your Access Database requires one)

) SQL Server

Database Ver. 2.1.10

License Allocation (Enterprise Edition Only)

If you have installed the Enterprise Edition of DTS FSM then the License Allocation screen is
available under the Help menu. The Basic and Professional Editions only work against the local
fixed drives of the system with DTS FSM installed and therefore only come with a single license
per system. The License Allocation screen allows the user to specify which systems are licensed
and therefore allowed to have their shares mapped via Mapped Drives and UNC paths. The local
system always consumes as a license (Standard or SAN).

(/) License Allocatio S~
License Type Local Server License

[NAS 'dd | License Type:
| Standard

Server Name License Type

NEMESIS | Standard Total Licenses

License (all types). 3
Total Allocated: 2
Total Remaining: 1

License By Type

Standard (Assigned/Total):  1/0
SAN (Assigned. Total): 0/0
MAS (Assigned/Total): 11

[me) [

Copyright © 2011 by Derry Technological Services, Inc. All rights reserved. Page 12
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Drives and UNC Paths (Enterprise Edition Only)

If you have installed the Enterprise Edition of DTS FSM then the Drives and UNC Paths
configuration screen is available under the Configuration menu. The Basic and Professional
Editions only work against the local fixed drives of the system with DTS FSM installed. The
Drives and UNC Paths configuration screen allows the user to specify which drives (local and
mapped) and UNC paths should be selectable when defining your Rule Sets. After you allocate
licenses to systems you can select where users will be allowed to run their Rule Sets from the
servers which are licensed. The local system always consumes a license and at least one local
drive must be selected.

() Drives and UNC Pat

| Select the Drives and UNC Paths that will be available when creating a Rule Set.
| -Only Drives and UMNC Paths for licensed system can be added here.
- All foced Drives for the local system are automatically listed.

System Drive or Share Auto Discover Shares
| ATHENS + | | TestHomeDirs - | | Add |

Drives Status
EX Online
WATHEM S DataBackup Online
WATHEMS Test Home Dirs COnline

When new UNC Paths are added to the screen they are verified to ensure they are available and
online.

Copyright © 2011 by Derry Technological Services, Inc. All rights reserved. Page 13
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Logging

DTS FSM supports three levels of logging of information when running a Rule Set including
Summary Logging (default level), User Friendly Output and Machine Output . By default the
log files are written to the installation directory.

- H "
.J ﬁugging Configuration LEIL

Log File Path: Logging Level

) 5 Logai
C:\Program Files (x86/\DTS\FSM', ) | e bl
(71 User Friendly Output

@ Machine Output
@ Comma Delimited (CSV)
) Tab Delimited

Each time a Rule Set iz un a log file is created for each Rule in the Rule Set.
The log files use the following name format :
RuleSetMame-RuleName-Date-Time log

Bample: Clean UpMAS-HomeDirRule-YYMMDD-HHMMSS Jog

The Date and Time used here is the time the Rule Set started to un.

Save ] l Cancel

Copyright © 2011 by Derry Technological Services, Inc. All rights reserved. Page 14
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Performance Settings

Some organizations have to be careful about the impact that management tools have on the
users actually trying to get work done using the storage systems under management. For that
reason, DTS FSM provides a performance throttle which inserts a delay between operations to
help keep down CPU spikes. Use the Performance Configuration screen to set a scan delay
value (defaults to zero). If you leave the Scan Delay setting at zero the system will not introduce
any delay when applying Rule Sets as they run.

The Real Time Output option is very useful when scanning very large systems with millions of
files as the default output settings will sometimes prevent FSM from working as fast as possible
and can cause the program to consume a good deal of system memory. The Real Time Output
setting along with the Logging Level setting allows you to minimize the output while the Rule Set
runs to get the best performance.

® Performance Configuration EE

Scan Delay (CPU Throttle)
Scan Delay Cumrent Value: 0 Scan Delay New Value: 0

The Scan Delay setting controls how fast the system will scan. A value of Zero means the system

will scan as fast as possible, but will have a greater impact the system's CPU load (default is 0).

You can set this value to any value from 0 fast scan, higher CPU)to 100 {slower scan, lower CPL).

U

1] 10 20 o 40 50 &0 0 a0 S0 100
Real Time Ouiput
This setting allows you to limit the real time output displayed when you run a Rule Set.
By tuning this value you can boost peformance when Rule Sets are run against very large volumes

with millions of files and directories.

Mzxdmum Real Time Output: Lists all changes on the Run Rule Set Screen

Madimum Real Time Output: Lists all changes on the Run Rule Set Screen

Medium Real Time Output: Lists files and Directories being changes as they are changed
Minimal Real Time Output: Tracks onby number of objects processed (best peformance) (default)

Copyright © 2011 by Derry Technological Services, Inc. All rights reserved. Page 15
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Active Directory Configuration

DTS FSM supports integrating with Active Directory for the purposes of running what are referred
to as Home Directory Rules. The interface to test that integration allows customization of the
Active Directory Connection String and subsequent testing.

Active Directory Connection String:
LDAP://dts local /DC=dts, DC<local

[7] Include Usemame and Password for LDAP connection
Usemam SSWIOITC Authentication Types
| Secure {defautt)

Filter Users by name (Example Jo*, “th):
test™
List of Users:

TestUszerl
TestlUser2

] Enable Logging

2 Uzers Found.
Selected User Home Directory

“exch1testuserhomedirsMestuser2$

Copyright © 2011 by Derry Technological Services, Inc. All rights reserved. Page 16



DTS File Security Manager User Guide

Activating the Software via the License File

By default, when DTS FSM is installed, the application is not activated and therefore the
functionality that actually makes changes to permissions and ownership are disabled. The
process of activating the software is straight forward and in most cases must only be done once
per installation.

Activation via the Web

DTS FSM allows some customers to retrieve their license file automatically via the Get License
menu item under the Help menu in cases where Internet access is available

License Allocation (Enterprise Edition Only)

The License file information includes the number of licenses and types of systems licensed. For
example if you purchase the Enterprise Edition with 3 Enterprise licenses, 4 Enterprise SAN
licenses and 3 Enterprise NAS licenses you can install the software on the server of your choice
and then configure which system the licenses apply towards via the Drives and UNC Paths
Configuration screen.

Activation via License File

These steps assume you have been sent either a copy of your license file or you have
downloaded it via a web link. Copy the license file into the same directory where you installed
FSM (i.e. look for the exe and put the file in that same directory). Once you have that file place,
unaltered you can use the following steps to activate your copy of FSM.

1. Open FSM and drop down the Help menu and Select About .

@ File Security Manager

Run  Configuration Reporting Languages | Help
Get License

FBiTE] Manage RUIB Set License Allocation

About

Create, edit or un a Rule Set
Rule Set Name Mumber of Rules Defined Date Created
Demo Rule Set 1- DTSphynds Takes Cwnership 8/28/2011

Demo Rule Set 1- DT5\Administrator Takes Ownership 1 8282011
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2. Asyou can see the program recognizes the license file (licYIEdipzSk1.dat in our
example), but it has not been enabled yet. Click on the Activate button

Product Version: 2.1.13 Product Code:

License Enabled: Mo License Code:
License Fle: lic1EdipzSk1.dat License Version:
License Expires: MNA Licensed Edition:

This product is licensed underthe terms End-User License Agreement
to: Unregistered

| Acivate || oK

Copyright © 2011 Derry Technological Services, Inc. All rights reserved.

3. Enter the email address and password associated with the product. These
should have been provided to you along with the license file. Click Activate .

Copyright © 2011 Derry Technological Services, Inc. All rights reserved.
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4. Once the activation is successful (provided you entered the correct email address and
password for the license) the About box will be display the license information as show in
the example below.

5. Ensure that the resulting screen shows the proper Edition, Version and Expiration date (if
any) as expected.

Copyright © 2011 by Derry Technological Services, Inc. All rights reserved. Page 19
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For Additional Information

Please refer to the DTS File Security Manager (FSM) Installation Guide, for more details on
installing the application in preparation for using the information given in this guide.

About DTS

DTS takes pride in our technical expertise in the area of security. We create products that enable
companies to automatically control access of their users’ stored files.

DTS Professional Services

For further assistance with DTS, contact your DTS representative at 603-845-3611.

DTS offers end-to-end consulting and training services to assist in the deployment and
configuration of your storage management solution. Our Professional Services staff includes
certified instructors for Microsoft and DTS systems as well as other technologies.

DTS
31 Emerald Drive
Derry, NH 03063-4066
Call: 1-603-845-3611
Website: www.dtsnh.com
Email: sales@dtsnh.com
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